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Cliptures Reference - Macintosh

Welcome to Cliptures!
Thank you for choosing Cliptures clip art. If this is your first Cliptures volume, please take a moment to read this
important information before using the Cliptures graphics.

Important - Opening Graphic Files
The Cliptures graphic files are computer files. They are not programs. In order to use the graphics, you must have a
software program that can read one of the included graphics file formats. You cannot double-click on a graphic file and
have it start up your software program!

There is nothing you have to install!
The Cliptures CDs are designed so that you can use the graphics directly from the CD without having to install anything
onto your hard disk. The only time you have to copy any of the Cliptures files to your hard disk is if you are using a layout
program that requires you to have its own CD inserted into your CD drive for the program to operate. If this is the case,
you can copy a Cliptures graphic, multiple graphics, or an entire Cliptures folder to your hard disk.

Copying Cliptures to your hard disk:
1. Locate the file or folder on the Cliptures CD that you want to copy to your hard disk.

2. Click on top of the file or folder and while continuing to hold down the mouse button, drag the file or folder on top of
your hard disk icon. (The icon for your hard disk will become highlighted when the file or folder is moved on top of it.)

3. Release the mouse button and the file or folder will be copied to your hard disk.

That's it!

Copying KoolKat to your hard disk:
If you would like to have KoolKat run from your hard disk so that you don't have to insert the Cliptures CD, you can use
the same technique to copy the KoolKat folder to your hard disk.

If you do decide to do this, you need to keep both the KoolKat files in the same folder.

If you have more than one KoolKat - Cliptures catalog, you only need one copy of the KoolKat Runtime file on your hard
disk. Just copy the 2nd, 3rd, etc... Cliptures - KoolKat file into the same folder as the KoolKat Runtime file and any other
KoolKat Cliptures files you have.

What's included on the CD
We've included all of the graphics in multiple formats to insure that you will have a format that is compatible with most
major software programs and printers. The following formats are included:

PICT - Vector

PICT - Raster

EPS - Vector (Adobe Illustrator)

Bonus! Cliptures - KoolKat SE image catalog with PICT - Vector, color images.

Color and Black & White versions too!
We've included both color and black & white versions of the graphics in each of the formats. The black & white versions
are great for creating layouts for coloring pages and craft projects for kids.

Note: There is important information included a little later in this document about the "vector" and "raster" formats and
why you may want to use one format or the other.
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The Cliptures CDs have 3 main folders:
1. KoolKat - This folder contains the Cliptures-KoolKat catalog for this Cliptures volume and the KoolKat Runtime
application.

2. Black & White - This folder contains the black & white versions of the Cliptures graphics.

3. Color - This folder contains the color versions of the Cliptures graphics.

Cliptures - KoolKat image catalog!
As a bonus we've included a set of the color, PICT-Vector images for this Cliptures volume in a special edition of our
KoolKat image catalog software. KoolKat is an easy way to add images to your layouts. You can open up the KoolKat
catalog, browse through the images, and "copy & paste", or, "drag & drop" an image from the KoolKat catalog into your
compatible software program's document.

System Requirements for KoolKat:

-Any Macintosh, Power Macintosh, or compatible computer running System 7.1 or later.

-4 MB of available RAM (for KoolKat), plus enough additional memory to run your other software program (that you
are creating your layouts in) at the same time.

-A software program (that you are creating your layouts in) that supports color, vectored PICT format graphics.

How to use the KoolKat - Cliptures Catalog:

(Copy & Paste)

With "copy & paste", you select an image in KoolKat, click the camera icon to copy the image, make your other software
program active, and paste in the image. Here are the steps:

1. Open the software program you are creating your layout in and open a new or an existing document.

2. Open the KoolKat catalog and find an image you want to use in your layout.

3. Click the KoolKat camera icon to copy the graphic.

4. Switch over to your layout software program's document.

5. Select the Paste command from your layout software program's Edit menu and the graphic will be pasted into your
document!

(Drag & Drop)

With "drag & drop", you select an image in KoolKat, click on the image and while holding down your mouse button, you
drag it onto the layout you are working on. When you release the mouse button on top of your layout, the image is
automatically copied into the other program's document.

Note: The Drag & Drop feature requires these things in order to work:

A. Your computer's operating system and the program you are using must both support drag & drop.

B. The image must be of a compatible graphics format for KoolKat and the program you are dragging to.

If you try using drag & drop and it doesn't work with your program, try the "copy & paste" method.

 Here are the steps for using "drag & drop":

1. Open the software program you are creating your layout in and open a new or an existing document.

2. Open the KoolKat catalog and find an image you want to use in your layout.

3. Resize the windows for both programs so that you can see the picture in KoolKat that you want to use and at least a
portion of the other program's document that you want to copy the image onto.

4. Bring KoolKat to the front. (Make it the active program.)
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5. Put your mouse arrow over the middle of the image in the KoolKat picture frame, then click and hold down the mouse
button.

6. Continue to hold down the mouse button and drag the mouse on top of the document where you want to drop the
image.

7. With the mouse pointer over the document, release the mouse button and the image will be copied from KoolKat to
the other program's document!

Note: When using "drag & drop" with some programs, you may get a beep and a message from KoolKat saying: "This
field is not modifiable." If you do, just click the OK button and continue. What is happening is that the program you are
working with is trying to actually cut the graphic from the KoolKat catalog instead of copying it. Because the KoolKat
catalog is locked, KoolKat displays that message and keeps the other program from being able to remove the image.

About the Graphic Formats:
Very Important: Please read this information about "vector" and "raster" format graphics!

Although there are probably a few hundred different types of computer graphic file formats, they all fall into one of these
two basic categories: "Raster" or "Vector". Because there are pros and cons to both formats in different situations and
with different software programs and printers, we've included versions of the Cliputres graphics in both formats to give
you the greatest flexibility.

PICT - Vector:

Note: We recommend that you first try the PICT - Vector version first. If you are not happy with the results, try the PICT
- Raster version.

A vector graphic is made up of a series of computer instructions that tell your software and printer how to show and
print  all of the individual objects, or, elements that make up a graphic. The resolution, or sharpness, of a vector graphic is
determined by the software program and printer that you are using.

Pros:

1. Vector graphics have transparent backgrounds when used in most software programs. Because they have transparent
backgrounds, you can layer them with other graphics, text, and background colors.

2. Their file size is smaller than a raster versions so they will typically print faster and do not require as much memory
from your software program.

3. Because "vector" graphics are made up of "objects" (instead of dots) the are easily resized and will maintain their
image quality and high resolution at very large or very small sizes.

Cons:

1. The PICT vector format image quality varies depending upon which software program you are using. In some
programs they look great, and in other programs they look jagged.

PICT - Raster:

A raster graphic is made up of dots (pixels) and each dot must have a color assigned to it. This not only includes the dots
that make up the image; it also includes some of the space around any irregular shaped image.

Pros:

1. The images maintain excellent image quality in practically any software program.

2. You can print them on practically any ink jet or laser printer with excellent quality.

Cons:

1. Raster graphics have a white rectangular background that surrounds the image. For that reason they do not work in
designs where you want to layer a graphic on top of another graphic, background, or text.
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2. Raster graphic files are generally larger than vector graphic files which may make them print slower.

3. They may use more of your software program's memory when you are creating a layout.

4. Because the images are made up of dots, resizing them to a larger size in your program may give them jagged edges.

EPS (Vector):

Also included is an Adobe Illustrator, EPS version of the Cliptures graphics. These are by far the best graphics quality
available for the Macintosh.

Unfortunately though most low cost color printers do not support PostScript. There are, however, a few programs that
will print PostScript (EPS) format graphics to non-PostScript printers with the same high quality PostScript results.
There are also a couple of commercial print utility programs that print PostScript graphics to non-PostScript printers as
well.

For Macintosh computers, the EPS format is really the best choice. We highly recommend your getting a program like
Canvas that will work with EPS graphics and will also print PostScript quality with an inexpensive color printer.
Although you will spend a little more money on the software and time learning to use it, the excellent results are well
worth the effort!

For current information about programs and utilities for working with EPS / Illustrator graphics, please visit our web site
at: www.CoolClipArt.com.

Pros:

1. Highest quality printing, best color reproduction, extremely smooth lines.

2. Transparent backgrounds so images can be layered or placed over colored backgrounds.

3. Easily resized and will maintain their image quality at very large or very small sizes.

Cons:

1. PostScript not supported by most inexpensive color printers. (Software programs and print utilities are available to
handle this though.)

Want more information?

If you would like more information about KoolKat, the Cliptures graphics formats, software tips, etc..., please visit our
web site at:

www.CoolClipArt.com

Using Cliptures Images With Your Software Programs
Note: Dream Maker Software graphics are produced in industry standard graphics file formats with proven track records
of dependable and reliable results. If you are having difficulty using an image with a particular program, you should:

1. Check the program's user manual to confirm that it supports the graphics format you are working with.

2. Check the program's manual again to make sure you are using the program correctly.

3. If you are still having problems, or if you have questions about how to import or open graphics with your software
program, you should contact the technical support department for that particular program. You should contact that
software company for help and to make sure their program is functioning properly, and to make sure that you are using it
properly before contacting Dream Maker Software.
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Programs & Recommended Formats
The following list includes a variety of popular software programs and recommended format(s) to use with those
programs. Compatible formats are listed in the order in which we recommend for that particular program. This
information applies to current versions of these programs only. (Older versions may not have the same capabilities.)

PrintShop - KoolKat, PICT-Vector, PICT-Raster

Adobe Illustrator - EPS (AI88)

Adobe PageMaker - KoolKat, PICT-Vector, PICT-Raster, EPS

Adobe PhotoShop - PICT-Raster, EPS

Canvas - EPS(AI88), PICT-Raster

ClarisWorks (word processor) - PICT-Raster, KoolKat, PICT-Vector, EPS

ClarisWorks (drawing) - PICT-Raster, KoolKat, PICT-Vector, EPS

Macromedia FreeHand - EPS (AI88)

Microsoft Powerpoint - PICT-Vector, EPS

Microsoft Word - KoolKat, PICT-Vector, PICT-Raster, EPS

Microsoft Works - KoolKat, PICT-Vector, PICT-Raster, EPS

PrintArtist - PICT-Raster

Note: The Cliptures graphics are compatible with many additional programs that are not included in this list. If the
program you are working with is not included, you should check its user manual to see if it supports PICT, EPS, or Adobe
Illustrator 88 format graphics. You can usually find information about this in the Index section of your software
program's user manual under "Graphics", or "Importing".

Program Tips

Importing graphics into programs.

The following provides basic information for opening or importing Cliptures images with a few popular software
programs. Information is listed for the current versions of the programs only. For detailed information about using and
manipulating the images with a particular program, you should consult that program's user manual. If your program
isn't listed here, you should check its user manual to see if it supports PICT, EPS, or Adobe Illustrator 88 format graphics.

Note: If KoolKat is listed next to the program, we recommend you first try KoolKat. The steps for using KoolKat were
covered earlier in this document.

Real Important Note: If the software layout program you are using requires that you have its CD in the CD drive in
order to run, you will need to copy the Cliptures graphic or graphics you want to use to your hard disk. The steps for
doing this were included earlier in this document.

PrintShop

(KoolKat (Copy & Paste), PICT-Vector, PICT-Raster, EPS)

1. Open a new or existing PrintShop document.

2. From PrintShop's File menu select the Import command.

3. Locate the name of the graphic you want to import and click the Insert button.

Note: (KoolKat works great with PrintShop!) PICT-Vector images print great in PrintShop but for some reason,
PrintShop does not treat the image backgrounds as transparent.  :-(
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ClarisWorks

(PICT-Raster, KoolKat (Drag & Drop), PICT-Vector, EPS)

Word Processor and Draw Documents:

1. Open a new or existing word processor document.

2. From the View menu choose the Show Tools command.

3. Change from the text tool to the pointer tool. (top left, looks like mouse pointer)

4. From the File menu choose the Insert command.

5. Locate the name of the graphic you want to import and click the Insert button.

6. Once the image appears in your document, you can click on the image and drag it around the page.

Opening in a Draw Document: (PICT-Raster, PICT-Vector)

1. From ClarisWorks' File menu choose the Open command.

2. Under Document Types choose Drawing

3. Locate the name of the graphic you want to open and click the Open button.

Adobe Illustrator

(EPS-AI88)

1. Start Illustrator.

2. From Illustrator's File menu select the Open command.

3. Locate the name of the graphic you want to open and click the Open button.

Note: Cliptures graphics can be modified with Adobe Illustrator. Illustrator will also let you print PostScript graphics to
non-PostScript printers with excellent results. EPS format graphics can be “placed” in an Illustrator document but they
cannot be modified.

Adobe PageMaker

(KoolKat, PICT-Vector, PICT-Raster, EPS)

1. Open a new or existing PageMaker document.

2. From PageMaker's File menu select the Place command.

3. Locate the name of the graphic you want to import and click the OK button.

4. When you are returned to the PageMaker document, click on the upper left location of where you would like the
graphic positioned on the page.

Canvas

(EPS-AI88 - Open as Adobe Illustrator format, convert to Canvas)

1. Start Canvas.

2. From the File menu select the Open command.

3. Locate the name of the graphic you want to open and click the Open button.

Note: The EPS version of the Cliptures graphics can be modified with Canvas. Canvas will also let you print PostScript
graphics to non-PostScript printers with excellent results!
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Macromedia FreeHand

(EPS-AI88)

1. Start FreeHand.

2. From FreeHand's File menu select the Open command.

3. Locate the name of the graphic you want to open and click the Open button.

Note: Cliptures graphics can be modified with FreeHand. FreeHand will also let you print PostScript graphics to non-
PostScript printers with excellent results. EPS format graphics can be “placed” in a FreeHand document but they cannot
be modified.

PrintArtist

(PICT-Raster)

1. Open a new or existing PrintArtist document.

2. From PrintArtist's File menu select the Import command.

3. Locate the name of the graphic you want to import and click the Open button.

For more information about using Cliptures graphics with these and other programs, please visit us our web site at:

www.CoolClipArt.com
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Cliptures Technical Support
Dream Maker Software graphics are produced in industry standard graphics file formats with proven track records of
dependable and reliable results. If you are having difficulty using an image with a particular program, you should:

1. Check the program's user manual to confirm that it supports the graphics format you are working with.

2. Check the program's manual again to make sure you are using the program correctly.

3. If you are still having problems, or if you have questions about how to import or open graphics with your software
program, you should contact the technical support department for that particular program. You should contact that
software company for help and to make sure their program is functioning properly, and to make sure that you are using it
properly before contacting Dream Maker Software.

Technical support for Cliptures is available from Dream Maker Software via the internet at:

www.CoolClipArt.com

You can also e-mail us with your questions to: support@CoolClipArt.com

Telephone technical support is available to our Registered Users Monday through Friday between 9:00 AM and 4:00 PM
(Mountain Time) at (303)762-1001.

Dream Maker Software

925 W. Kenyon Ave. #16

Englewood, CO 80110

USA

Telephone: (303)762-1001

FAX: (303)762-0762

©1999 Dream Maker Software with all rights reserved. Dream Maker Software is a registered trademark of Dream Maker
Software. Cliptures, CoolClipArt, and KoolKat are trademarks of Dream Maker Software. All other brand and product
names are trademarks or registered trademarks of their respective holders.


	Main
	Visit us on the Internet!

	Vol. 49 - Bible Images
	Windows Help
	Macintosh Help
	Welcome to Cliptures!
	Opening Graphic Files
	Nothing to Install
	Copying Cliptures to your hard disk:
	Copying KoolKat to your hard disk:
	KoolKat image catalog!
	System Requirements for KoolKat:
	How to use the KoolKat - Cliptures Catalog:
	(Copy & Paste)
	(Drag & Drop)

	About the Graphic Formats:
	PICT - Vector:
	PICT - Raster:
	EPS (Vector):

	Using Cliptures Images With Your Software Programs
	Recommended Formats
	Program Tips
	Importing graphics into programs.
	PrintShop
	ClarisWorks
	Adobe Illustrator
	Adobe PageMaker
	Canvas
	Macromedia FreeHand
	PrintArtist

	Technical Support

	Software License

